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Important Notice  

© 2012 Servotronix Motion Control Ltd.  

All rights reserved. No part of this work may be reproduced or transmitted in any 

form or by any means without prior written permission of Servotronix Motion 

Control Ltd. 

Disclaimer 

The information in this manual was accurate and reliable at the time of its 

release. Servotronix Motion Control Ltd. reserves the right to change the 

specifications of the product described in this manual without notice at any time.  

Trademarks 

Servotronix always in motion™ is a trademark of Servotronix Motion Control Ltd. 

CANopen® and CiA® are registered community trademarks of CAN in 

Automation e.V. 

All other proprietary names mentioned in this manual are the trademarks of their 

respective owners. 

Contact Information 

Servotronix Motion Control Ltd. 

21C Yagia Kapayim Street 

Petach Tikva 49130, Israel 

Tel: +972 (3) 927 3800 

Fax: +972 (3) 922 8075 

Website: www.servotronix.com  

Email: info@servotronix.com 

http://www.servotronix.com/
mailto:info@servotronix.com
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Customer Service 

Servotronix is committed to delivering quality customer service and support for 

all our products. Our goal is to provide our customers with the information and 

resources so that they are available, without delay, if and when they are needed. 

In order to serve in the most effective way, we recommend that you contact 

your local sales representative for order status and delivery information, product 

information and literature, and application and field technical assistance. If you 

are unable to contact your local sales representative for any reason, please use 

the most relevant of the contact details below: 

For technical support, contact: 
tech.support@servotronix.com 

To order products, contact:  
orders@servotronix.com 

For all other inquiries regarding LVD drives or other Servotronix products, 

contact: 
customer.service@servotronix.com  

Part Number  

For ordering the standard LVD, use part number: LVD48701 

Warranty  

The warranty is valid for 12 months from the date of shipment and applies only if 

material or workmanship is found to be defective. The warranty will be invalid if 

the customer fails to install, operate or maintain the product in accordance with 

the instructions in this user manual.  

During the warranty period, the owner must pay the cost of shipping the product 

to the factory for repair, and Servotronix will pay for shipping the repaired 

product to the customer.  

After the warranty period has expired, all shipping costs will be the responsibility 

of the customer. 

Before returning the product, the customer must first request a Return Materials 

Authorization (RMA) number from Servotronix by email to rma@servotronix.com 

The complete Warranty Statement can be found in the Terms and Conditions 

document on the Servotronix website: 

www.servotronix.com/customer-service.html 

 

mailto:tech.support@servotronix.com
mailto:orders@servotronix.com
mailto:customer.service@servotronix.com
mailto:rma@servotronix.com
http://www.servotronix.com/customer-service.html
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1 Introduction 

1.1 Documentation 

1.1.1 About This Manual  

This manual describes the Servotronix LVD digital servo drive. 

It provides the information required for installation, configuration and basic 

operation of the LVD unit. 

Note: This document is meant for skilled personnel who have been trained to 

work with the equipment described.  

1.1.2 Documentation Set for the LVD 

This manual is part of a documentation set. The set consists of the following: 

 LVD User Manual. Hardware installation, configuration and operation. 

 LVD VarCom Reference Manual. Parameters and commands used to 

program the LVD. 

 LVD CANopen Reference Manual. LVD implementation of CiA 402 and 

301 protocols. 

1.2 Safety 

The LVD is designed according to the guidelines of safety standard 

IEC 61800-5-1 second edition. In addition, the LVD is considered partly 

completed machinery according to EU directive 2006/42/EC (Article 2, 

Clause (g)), and is intended to be incorporated into other machinery. 

Only qualified personnel are permitted to assemble, commission, and maintain 

this equipment. Properly qualified personnel are persons who are familiar with 

the assembly, installation, commissioning and operation of motors, and who 

have the appropriate qualifications for their jobs.  

For safety, perform all of the following:  

 Read all available documentation before assembling and commissioning. 

Incorrect handling of products can result in personal injury and equipment 

damage. Strictly heed all technical information regarding installation 

requirements.  

 It is vital to ensure that all system components are connected to earth 

ground. Electrical safety is provided through a low-resistance earth ground 

connection (chassis). 

 Be aware that during operation the product has electrically charged 

components and hot surfaces. The heat sink can reach a temperature of 

80°C (176°F). Power cables can carry a high voltage even when the motor 

is not rotating. 

 To avoid electric arcing and hazards to personnel and electric contacts, 

never disconnect or connect the product while the power source is 

energized. 
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1.3 Standards Compliance 

 CE: The LVD is designed to meet the CE mark requirements for EMC. 

 UL: Testing for conformance to UL508C is pending. UL508C conformance 

will apply only to operation up to 32 VDC. 

 RoHS: The LVD complies with the Directive on the Restriction of the Use of 

Certain Hazardous Substances in Electrical and Electronic Equipment 

2002/95/EC, commonly referred to as the Restriction of Hazardous 

Substances Directive (RoHS). 
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2 Product Description 

2.1 Overview 

2.1.1 General Description 

The LVD is a compact, low-voltage, single-axis servo drive. LVD is a fully digital 

amplifier designed for driving brushed and brushless DC motors. 

The LVD is powered by a 12-48 VDC supply, and is capable of sourcing 7A RMS 

continuous current, and 12A RMS peak current. The LVD can be operated in 

current, velocity or position mode. The PWM switching frequency can be set up 

to 100 kHz. Combined with advanced space-vector modulation, this enables 

operation with low inductance motors while minimizing current ripple and 

eliminating acoustic noise.  

The LVD supports both RS-232 and CANopen communication interfaces, and 

operates in compliance with DS402 CANopen® device profile.  

Configuration of the drive can be easily performed using the Axis Manager 

software supplied with the LVD. 

2.1.2 Product Options 

No product options are currently available. 

2.2 Technical Specifications 

2.2.1 Mechanical  

Refer to Figure ‎3-2 for a mechanical drawing showing the dimensions of the LVD. 

Table ‎2-1. LVD Mechanical Specifications 

Feature Specification 

Weight 250g, not including mating connectors 

Dimensions (L x W x H)  117 x 83.5 x 21.5 mm 

(L x W x H)  4.6 x 3.3 x 0.85 inch 

Mounting Brackets for vertical or horizontal mounting 
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2.2.2 Electrical  

Table ‎2-2. LVD Electrical Specifications 

Feature Specification 

Motor Up to 475W 

Brush DC 

Brushless DC 

Control modes Interpolated position mode (PVT) 

Position control 

Velocity control 

Torque (current) control 

Feedback  Incremental encoder with Hall sensors or 

commutation tracks 

RMS continuous current  7 A 

RMS peak current  12 A 

Logic voltage (separate supply) 10 – 36 VDC 

Bus voltage (separate supply) 12 – 48 VDC 

Maximum output voltage 100% of operating voltage 

PWM frequency 16 or 100 kHz 

Maximum incremental encoder 

frequency 

3 MHz 

Sample rate - current loop 16 kHz 

Sample rate - velocity loop 5.33 kHz 

Sample rate - position loop 2.66 kHz 

Table ‎2-3. Derating at 16 kHz PWM Frequency 

  DC Brushless Motor DC Brush Motor 

Input voltage (V) 24 VDC 36 VDC 48 VDC 24 to 48 DC 

Output current (A) 6 7 6 7 6 7 7 

Maximum ambient 

temperature (°C) 

45 35 45 35 45 35 45 

Table ‎2-4. Derating at 100 kHz PWM Frequency 

 DC Brushless Motor DC Brush Motor 

Input voltage (V) 24 VDC 36 VDC 48 VDC 24 VDC 48 VDC 

Output current (A) 4.5 5.5 5 6 3.5 4.5 6.5 5.5 

Maximum ambient 

temperature (°C) 

45 35 45 35 45 35 45 45 
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2.2.3 Inputs and Outputs 

The I/O interfaces are located on the front panel of the LVD, as shown in 
Figure ‎3-4. 

Table ‎2-5. LVD Input and Output Specifications 

Feature Specification 

Inputs 6 opto-isolated digital inputs, configurable as 

dedicated inputs (over-travel limits and Home) 

Input Voltage Range: 6.5V to 24V 

Maximum current consumption: 10.7mA 

Input resistance: 2.5KΩ   

2 configurable ±10 VDC analog inputs, 

Gain Error < ±1.5%, Offset Error <±1.5% 

Analog to Digital 12 Bit Resolution 

Worst accuracy: 11.978 bits Band width: 8K 

Outputs 2 opto-isolated digital outputs, controllable over 

the CAN bus 

Maximum current consumption: 110mA 

External Enable 1 opto-isolated digital input (optional bypass 

using DIP switch) 

Input Voltage Range: 6.5V to 24V 

Maximum current consumption: 10.7mA 

Input resistance: 2.2KΩ   

2.2.4 Communication 

The communication interfaces are located on the front and side panels of the 

LVD, as shown in Figure ‎3-4 and Figure ‎3-6. 

Table ‎2-6. LVD Communication Specifications 

Feature Specification 

Serial RS-232 (115 kbps) 

CAN CANopen DS301 

CANopen DS402 

2.2.5 Environment 

Table ‎2-7. LVD Environment Specifications 

Feature Specification 

Operating temperature  -10 to 45°C   (14° to 113°F) 

Storage temperature -25 to 55°C   (-13° to 131°F) 

Humidity 5 to 95%, non-condensing  

 

Note the effect of ambient temperatures on output current, as specified in 

Table ‎2-3 and Table ‎2-4. 
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3 Installation 

3.1 Preparation 

 If not using ready-made cable assemblies, use Molex hand crimping tool 

63819-0500 to crimp the wires for all connectors except P7 (Bus Power and 

Motor). 

 Wires for all connectors, except P7, must be 24-30 AWG. For P7 the range is 

12-30 AWG. Any deviation from these specifications may cause wires to 

come loose.  

 Before crimping, strip 2 mm at the end of wire, as shown in Figure ‎3-1. 

  

 Figure ‎3-1. Stripped Wire in Crimp Pin 

 To set the switches on the unit, you will need a precision, small screwdriver. 

 To mount the unit, you will need M4 or #8 screws and an appropriate 

fastening tool. 4 screws are needed for the side brackets. 2 screws are 

needed for the rear bracket. 
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3.2 Mechanical Installation 

 

Figure ‎3-2. LVD Dimensions and Mounting Holes 

3.2.1 Mounting the LVD   

The unit can be positioned vertically or horizontally. The unit can be mounted 

using the bracket on the rear, which has two mounting holes. Alternately, it can 

be mounted using the two side brackets, each of which has two mounting holes. 

3.2.2 Mounting Multiple LVD Units 

When mounting multiple LVD units within a cabinet or enclosure, it is 

recommended that the units be spaced at least 20 mm apart.  

It is important to maintain an ambient temperature within the enclosure that 

does not exceed 45°C (113°F). 

3.3 Electrical Installation  

3.3.1 Wiring Guidelines 

The environment into which any electronic control system is installed can effect 

its operation. Attention to proper installation and field wiring are of prime 

importance to ensure long-term and trouble-free operation. Be sure you are 

familiar with and follow the installation and wiring instructions in this section. In 

addition to these practices, some localities and industries may require applicable 

electrical and safety codes, laws, and standards. 

Particular care should be used when designing the layout of an enclosure. Efforts 

to separate power wires from small signal wires should be taken. The following 

guidelines highlight some important wiring practices:  

 Control and signal cables must be separated from power and motor cables. 
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 Control and signal cables must be shielded to reduce the effects of radiated 

interference. 

 Where control cables must cross power or motor cables, they should cross 

at a 90º angle, if possible. This reduces the field coupling effect. 

3.3.2 Enclosure 

The LVD is designed for panel assembly. This panel assembly should then be 

mounted in a metallic enclosure. Enclosures are supplied by the manufacturers 

of the final product and must meet the environmental IP rating of the end 

product. To ensure proper grounding (and to optimize EMC), the enclosure 

should have continuous ground continuity maintained between all metal panels. 

This ground continuity is intended to be both a safety ground and a high 

frequency ground. The unit should be mounted on a back plane, which is 

installed into the enclosure. Ideally, the back plane should be an unpainted 

metallic surface to optimize electrical bonding of the frame and provide the 

lowest possible impedance path to earth ground. These enclosures also provide 

added safety. 

3.3.3 Grounding 

System grounding is essential for proper performance of the drive system. A 

ground bus bar may be used as a single point ground for the system. Safety 

grounding should be provided to all pieces of the system from a star point. 

In addition to the safety grounding, a high frequency ground must be provided 

that connects the back panel to the enclosure and to earth ground. The objective 

is to provide an extremely low impedance path between the filters, drives, power 

supplies, and earth ground.  

This high frequency ground is accomplished with the use of a flat braid or copper 

bus bar. It is important not to rely on a standard wire for the high frequency 

ground. In general, wire has an inductance of 8 nH per inch, regardless of 

diameter. At higher frequencies, this unwanted inductance between grounds 

equates to limited filter performance. When connecting high frequency grounds, 

use the shortest braid possible. 

3.3.4 Bonding 

The proper bonding of shielded cables is imperative for minimizing noise 

emissions and increasing immunity levels of the drive system. Its effect is to 

reduce the impedance between the cable shield and the back panel. Servotronix 

recommends that all shielded cables be bonded to the back panel. 

Power input wiring does not require shielding (screening) if the power is fed to 

the cabinet (enclosure) via metalized conduit. If the metalized conduit is used 

with proper high frequency grounds, bonding technology, and recommended 

wire routing, then power input wire shielding has no affect. In the event that 

metalized conduit is not implemented into the system, shielded cable is required 

on the power input wires and proper bonding technologies should be 

implemented. The motor and feedback cables should have the shield exposed as 

close to the drive as possible. 

3.3.5 CE Filtering Techniques 

The LVD meets the CE Mark standards stated in the Standards Compliance 

section in this manual. It is imperative to apply proper bonding and grounding 

techniques, described above, when incorporating EMC noise filtering components 

for the purpose of meeting this standard. 
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Noise currents often occur in two types. The first is conducted emissions that are 

passed through ground loops. The quality of the system grounding scheme 

inversely determines the noise amplitudes in the lines. These conducted 

emissions are of a common-mode nature from line to neutral (or ground). The 

second is radiated high-frequency emissions usually capacitively coupled from 

line-to-line and are differential in nature. 

To properly mount the filters, the enclosure should have an unpainted metallic 

surface. This allows for more surface area to be in contact with the filter housing 

and provides a lower impedance path between this housing and the back plane. 

The back panel, in turn, has a high frequency ground strap connection to the 

enclosure frame or earth ground.  

3.3.6 Motor Line Filtering 

Motor filtering may not be necessary for CE compliance of LVD systems. 

However, this additional filtering increases the reliability of the system. Poor 

non-metallic enclosure surfaces and lengthy, unbonded (or unshielded) motor 

cables that couple noise line-to-line (differential) are just some of the factors 

that lead to the necessity of motor lead filtering. 

Motor lead noise may be either common-mode or differential. The common-

mode conducted currents occur between each motor lead and ground (line-to-

neutral). Differential radiated currents exist from one motor lead to another 

(line-to-line). The filtering of the lines feeding the motor provide additional 

attenuation of noise currents that enter surrounding cables and equipment I/O 

ports in close proximity. 

Differential mode currents commonly occur with lengthy motor cables. As the 

cable length increases, so does its capacitance and its ability to couple noise 

from line-to-line. While every final system is different and every application of 

the product causes a slightly different emission profile, it may become necessary 

to use differential mode chokes to provide additional noise attenuation to 

minimize the radiated emissions. The use of a ferrite core (placed at the drive 

end) on each motor lead (shown in the diagram below), attenuates differential 

mode noise and lower frequency (30-60 MHz) broadband emissions to within 

specifications. You should wrap each motor lead through the core several times, 
as shown in Figure ‎3-3. 

Warning: Never wrap a ground lead through a core. 

 

Figure ‎3-3. Mode Line Filtering  

Common mode currents commonly occur from noise spikes created by the PWM 

switching frequency of the drive. The use of a ferrite or iron-powder core toroid 

places common mode impedance in the line between the motor and the drive. 

The use of a common mode choke on the motor leads increases signal integrity 

of encoder outputs and associated I/O signals. 
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3.3.7 I/O Filtering  

I/O filtering may be desirable (depending on system installation, application, and 

integration with other equipment). To avoid unwanted signals entering and 

disturbing the drive system or other associated equipment, place ferrite cores on 

I/O lines. The Fair-Rite Products Corporation has a varied selection of ferrite 

parts used for I/O filtering and noise attenuation. 

3.3.8 Interfaces 

The unit interfaces are located on the front and side panels of the LVD, as shown 
in Figure ‎3-4, Figure ‎3-5, and Figure ‎3-6. 

Table ‎3-20 lists the functions of the LED indicators. 

 

Figure ‎3-4. Front Panel 

 

 

Figure ‎3-5. Right Side Panel 

 

 

Figure ‎3-6. Left Side Panel 

http://www.fair-rite.com/newfair/index.htm
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3.3.9 Connector Pinouts 

Table ‎3-1 through Table ‎3-18 provide the pin assignments and detailed 

information you will need to prepare the cables required for the LVD. 

When preparing the cables, be sure the pinout and polarity of the mating 

connectors are in accordance with the printed labels on the LVD, and as 

described in detail in this section.  

Bus Power and Motor – P7  

Table ‎3-1. Bus Power and Motor Interface  

Pin Function 

Description  

Brushless DC Motor 
Brush DC & Voice-coil 

Motors 

1 BUS + VDC supply for the bus; 

regulated or unregulated 

VDC supply for the bus; 

regulated or unregulated 

2 BUS -  Bus ground Bus ground 

3 REGEN OUT Regeneration power output Regeneration power output 

4 MPHASEC Motor phase C No connection 

5 MPHASEB Motor phase B Motor terminal 1 

6 MPHASEA Motor phase A Motor terminal 2 

7 CHASSIS Motor ground.  

Refer to Section ‎3.3.3 

Motor ground.  

Refer to Section ‎3.3.3 

Warning: Use either Pin 7 or the LVD chassis itself for Motor ground.  

Do not use both. 

 

Figure ‎3-7. Bus Power and Motor Mating Connector  

For Bus Power and Motor signals, either a single connector, or two separate 
connectors can be used, as specified in Table ‎3-2 

Table ‎3-2. Bus Power and Motor Mating Connector 

Item 

Specification   

Bus and Motor Bus  

(Pins 1-2-3) 

Motor  

(Pins 4-5-6-7) 

Manufacturer Phoenix Contact Phoenix Contact Phoenix Contact 

Part Number 1754546 1754465 1754481 

Wire Gauge 12-30 AWG 12-30 AWG 12-30 AWG 
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Logic Power – P2 

Table ‎3-3. Logic Power Interface  

Pin Function Description 

1 +VCC 10 to 36 VDC power supply 

2 GND Power supply ground 

 

Figure ‎3-8. Logic Power Mating Connector 

Table ‎3-4. Logic Power Mating Connector 

Item Specification 

Manufacturer Molex 

Part Number 0355070200  

Crimp Pins Reel: 0502128000 

Bag: 0502128100 

Wire Gauge 24-30 AWG 

 

http://www.molex.com/molex/products/datasheet.jsp?part=active/0355070200_CRIMP_HOUSINGS.xml&channel=Products&Lang=en-US
http://www.molex.com/molex/products/datasheet.jsp?part=active/0502128000_CRIMP_TERMINALS.xml&channel=Products&Lang=en-US
http://www.molex.com/molex/products/datasheet.jsp?part=active/0502128100_CRIMP_TERMINALS.xml&channel=Products&Lang=en-US
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Encoder – J8 

Table ‎3-5. Encoder Interface 

Pin Function 
Description 

Differential Encoder Single-Ended Encoder 

1 +VENCODER 
5 VDC supply for the 

encoder 

5 VDC supply for the 

encoder 

2 GND Encoder ground Encoder ground 

3 Channel A+ 
Input from encoder 

channel A 

Input from encoder 

channel A 

4 Channel A- 
Input from encoder 

channel A complement 
Not in use 

5 Channel B+ 
Input from encoder 

channel B 

Input from encoder 

channel B 

6 Channel B- 
Input from encoder 

channel B complement 
Not in use 

7 Index + Input from encoder Index Input from encoder Index 

8 Index - 
Input from encoder Index 

complement 
Not in use 

 

Figure ‎3-9. Encoder Mating Connector 

Table ‎3-6. Encoder Mating Connector 

Item Specification 

Manufacturer Molex 

Part Number 0355070800  

Crimp Pins Reel: 0502128000 

Bag: 0502128100 

Wire Gauge 24-30 AWG 

 

 

http://www.molex.com/molex/products/datasheet.jsp?part=active/0355070200_CRIMP_HOUSINGS.xml&channel=Products&Lang=en-US
http://www.molex.com/molex/products/datasheet.jsp?part=active/0502128000_CRIMP_TERMINALS.xml&channel=Products&Lang=en-US
http://www.molex.com/molex/products/datasheet.jsp?part=active/0502128100_CRIMP_TERMINALS.xml&channel=Products&Lang=en-US
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Hall Sensor – J5 

Table ‎3-7. Hall Sensor Interface 

Pin Function Description 

1 +VHALL 5 VDC supply for the Hall sensors 

2 GND Hall sensor ground 

3 Hall sensor 1 Input from Hall sensor 1 

4 Hall sensor 2 Input from Hall sensor 2 

5 Hall sensor 3 Input from Hall sensor 3 

 

Figure ‎3-10. Hall Sensor Mating Connector  

Table ‎3-8. Halls Sensor Mating Connector  

Item Specification 

Manufacturer Molex 

Part Number 0355070500  

Crimp Pins Reel: 0502128000 

Bag: 0502128100 

Wire Gauge 24-30 AWG 

 

 

http://www.molex.com/molex/products/datasheet.jsp?part=active/0355070200_CRIMP_HOUSINGS.xml&channel=Products&Lang=en-US
http://www.molex.com/molex/products/datasheet.jsp?part=active/0502128000_CRIMP_TERMINALS.xml&channel=Products&Lang=en-US
http://www.molex.com/molex/products/datasheet.jsp?part=active/0502128100_CRIMP_TERMINALS.xml&channel=Products&Lang=en-US
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I/O – J9 

Table ‎3-9. I/O Interface 

Pin Function Description 

1 Digital input common Return line for the Digital Inputs 

2 Digital output common Return line for the Digital Output 

3 Digital input  Digital input 1 

4 Digital input  Digital input 2 

5 Digital input  Digital input 3 

6 Digital input  Digital input 4 

7 Digital output  Digital output 1 

8 Analog Input 1- Analog Differential Input 1- (Low) 

9 Analog Input 1+ Analog Differential Input 1+ (High) 

 

Figure ‎3-11. I/O Mating Connector  

Table ‎3-10. I/O Mating Connector  

Item Specification 

Manufacturer Molex 

Part Number 0355070900  

Crimp Pins Reel: 0502128000 

Bag: 0502128100 

Wire Gauge 24-30 AWG 

 

http://www.molex.com/molex/products/datasheet.jsp?part=active/0355070200_CRIMP_HOUSINGS.xml&channel=Products&Lang=en-US
http://www.molex.com/molex/products/datasheet.jsp?part=active/0502128000_CRIMP_TERMINALS.xml&channel=Products&Lang=en-US
http://www.molex.com/molex/products/datasheet.jsp?part=active/0502128100_CRIMP_TERMINALS.xml&channel=Products&Lang=en-US
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Extended I/O - J7 

Table ‎3-11. Extended I/O 

Pin Function Description 

1 ENC_STRB+ Encoder Strobe+ 

2 ENC_STRB- Encoder Strobe- 

3 Digital input  Digital input 5 

4 Digital input  Digital input 6 

5 Digital output  Digital output 2 

6 Analog Input 2- Analog Differential Input 2- (Low) 

7 Analog Input 2+ Analog Differential Input 2+ (High) 

 

 

Figure ‎3-12. Extended I/O Connector 

Table ‎3-12. Extended I/O Connector 

Item Specification 

Manufacturer Molex 

Part Number 0355070700  

Crimp Pins Reel: 0502128000 

Bag: 0502128100 

Wire Gauge 24-30 AWG 

 

 

 

http://www.molex.com/molex/products/datasheet.jsp?part=active/0355070200_CRIMP_HOUSINGS.xml&channel=Products&Lang=en-US
http://www.molex.com/molex/products/datasheet.jsp?part=active/0502128000_CRIMP_TERMINALS.xml&channel=Products&Lang=en-US
http://www.molex.com/molex/products/datasheet.jsp?part=active/0502128100_CRIMP_TERMINALS.xml&channel=Products&Lang=en-US
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External Enable – J2 

If the External Enable connector is being used, the EN.BYPASS  switch (DIP 

switch 2) must be set to the OFF position.  

If the External Enable connector is not being used, the DIP switch 2 must be set 
to the ON position. Refer to Section ‎3.3.10. 

Table ‎3-13. External Enable Interface  

Pin Function Description 

1 EXT_EN+ External enable positive 

2 EXT_EN- External enable negative 

 

Figure ‎3-13. External Enable Mating Connector 

Table ‎3-14. External Enable Mating Connector 

Item Specification 

Manufacturer Molex 

Part Number 0355070200  

Crimp Pins Reel: 0502128000 

Bag: 0502128100 

Wire Gauge 24-30 AWG 

 

 

http://www.molex.com/molex/products/datasheet.jsp?part=active/0355070200_CRIMP_HOUSINGS.xml&channel=Products&Lang=en-US
http://www.molex.com/molex/products/datasheet.jsp?part=active/0502128000_CRIMP_TERMINALS.xml&channel=Products&Lang=en-US
http://www.molex.com/molex/products/datasheet.jsp?part=active/0502128100_CRIMP_TERMINALS.xml&channel=Products&Lang=en-US
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RS-232 – J3-0 

Table ‎3-15. RS-232 Interface 

Pin Function Description 

1 RX LVD RS-232 receive 

2 TX LVD RS-232 transmit 

3 GND RS-232 ground 

 

Figure ‎3-14. RS-232 Mating Connector  

Table ‎3-16. RS-232 Mating Connector  

Item Specification 

Manufacturer Molex 

Part Number 0355070300  

Crimp Pins Reel: 0502128000 

Bag: 0502128100 

Wire Gauge 24-30 AWG 

http://www.molex.com/molex/products/datasheet.jsp?part=active/0355070200_CRIMP_HOUSINGS.xml&channel=Products&Lang=en-US
http://www.molex.com/molex/products/datasheet.jsp?part=active/0502128000_CRIMP_TERMINALS.xml&channel=Products&Lang=en-US
http://www.molex.com/molex/products/datasheet.jsp?part=active/0502128100_CRIMP_TERMINALS.xml&channel=Products&Lang=en-US
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CAN J3-1 and J3-2 

Two connectors are provided for CAN bus connectivity. Either connector can be 

used for input or output signals. 

Pins are wired-through so that drives can be daisy-chained and controlled with a 

single connection to the user’s CAN interface. The CAN termination resistor 

should be activated in the last drive in the chain, using the DIP switch labeled 

CAN TERM. 

Table ‎3-17. CAN Interface 

Pin Function Description 

1 CAN Low CAN low bus line 

2 CAN High CAN high bus line 

3 GND CAN ground 

 

Figure ‎3-15. CAN Mating Connector  

Table ‎3-18. CAN Mating Connector  

Item Specification 

Manufacturer Molex 

Part Number 0355070300  

Crimp Pins Reel: 0502128000 

Bag: 0502128100 

Wire Gauge 24-30 AWG 

 

http://www.molex.com/molex/products/datasheet.jsp?part=active/0355070200_CRIMP_HOUSINGS.xml&channel=Products&Lang=en-US
http://www.molex.com/molex/products/datasheet.jsp?part=active/0502128000_CRIMP_TERMINALS.xml&channel=Products&Lang=en-US
http://www.molex.com/molex/products/datasheet.jsp?part=active/0502128100_CRIMP_TERMINALS.xml&channel=Products&Lang=en-US
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3.3.10 DIP Switches 

Drive Address – SW1 

The drive’s CAN ID, or node address, is set by means of 6 DIP switches. The 

address can be a value in the range 0–63. Each device on the network must 

have a different address.   

When interfacing to the LVD via the RS232 serial port, the LVD address must be 

set to a non-zero value. 

When working with CAN bus, the last device on the network must have a 

termination resistor between the CAN terminals. The LVD provides this 

functionality via the DIP switch labeled CAN TERM. 

Note:  When setting the switches, refer to the labels on the LVD (and not the 

numbers on the switches), as shown in Figure ‎3-16. 

Table ‎3-19. Drive Address Switches  

Label on  

LVD 
Description # on Switch 

Binary Code = 

Valence 

ADD 5 Address 5 8 25 = 32 

[4] Address 4 7 24 = 16 

[3] Address 3 6 23 = 8 

[2] Address 2 5 22 = 4 

[1] Address 1 4 21 = 2 

ADD 0 Address 0 3 20 = 1 

EN. BYPASS External Enable Bypass 2  

CAN TERM CAN Termination 1  

 

Note:  EN.BYPASS (DIP switch 2) must be in the OFF position if External Enable 

is being used. The switch must be in the ON position if External Enable 

is not in use. 

 

 

Figure ‎3-16. DIP Switches 
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3.3.11 Connecting the LVD 

The cables can be connected in any sequence. Similarly, the switches for the 

drive address can be set at any point during the installation. 

Warning: Make sure the power supplies are disconnected before making the 

cable connections. 

Note: Although the bus/motor power and the logic power can be connected to 

the same power supply, it is recommended that they be connected to separate 

power supplies to prevent electrical noise. 

Note: The CAN connectors are jumpered internally; either connector can be 

used for input or output signals. 

Connect the cables 

 Connect the LVD to ground. 

 Connect the bus power and the motor. 

 Connect the logic power. 

 Connect the encoder. 

 Connect the Hall sensors, if required. 

 Connect the External Enable, if required. 

 Set DIP switch 2 in accordance with the absence or presence of the External 

Enable connection. 

 Connect the LVD to host computer through either the RS-232 or CAN 

interface. 

Set the drive address switches 

Refer to Table ‎3-19 for the drive addresses and switch settings. 

3.4 Axis Manager Software Installation 

The Axis Manager is graphical management tool that allows you to 

configure drive parameters and control multiple drives. 

The Axis Manager software is available for download from the Servotronix 

website. 

1. On the Servotronix website, go to the LVD product page.  

2. Download and save the following file/s to the host computer: 

 AxisManagerSetup.zip. 

 If CAN communication protocol will be used, also download the EDS file  

3. Extract the AxisManager.ZIP file. It contains one file, 

AxisManagerSetup.exe 

4. Run AxisManagerSetup.exe, and follow the on-screen prompts to install 

the software. 

By default, the software is installed under Windows Programs in the folder 

\Servotronix\ Axis Manager. 

http://www.servotronix.com/LVD.html


Installation LVD 

22 User Manual 

5. When the installation is complete, you will see the Axis Manager shortcut on 

your desktop. 

  

3.5 Power Up 

1. Turn on logic power. 

2. Turn on bus power. 

3. Make sure the Bus and Status LEDs on the front panel light up, as described 

in the following section. 

3.6 Indicators 

The LVD has LEDs on the front panel, as shown in Figure ‎3-17. 

Table ‎3-20 lists the functions of the LED indicators. 

 

Figure ‎3-17. LED Indicators on Front Panel 

Table ‎3-20. LED Indicators 

Name Color Function 

Bus Yellow  ON – Bus power is connected and powered to at 

least 5 VDC. 

Status Green Blinking – The drive is operational and ready to 

be enabled. No faults. 

ON – The drive is enabled. No faults. 

 Red ON – A fault has been detected and needs 

attention.  

Blinking – A fault that was detected no longer 

exists, but has not yet been cleared. (CLRFLT 

command). 

 

For more information about faults, refer to the chapter Troubleshooting. 
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4 Configuration 

4.1 Variables and Commands 

Drive functionality is configured using various commands and variables, which 

are communicated over the serial port or over CAN bus. 

Commands and variables are identified by both a mnemonic (VarCom) name and 

a CANopen index. For example, MPOLES is the VarCom equivalent of CANopen 

index 0x2442. 

VarCom instructions, which are used with serial communications, are detailed in 

the LVD VarCom Reference Manual.  

CANopen instructions are described in the LVD CANopen Reference Manual. 

Some variables are read-only, while others allow read/write access. Variables 

can be stored in the LVD’s non-volatile memory (EEPROM) for use at each 

power-up.  

Drives are shipped from the factory with motor parameters set to zero and 

application parameters set to their default values. 

4.2 Axis Manager Software 

4.2.1 About Axis Manager 

Axis Manager is a graphic interface provided with the LVD to enable setup, 

configuration and tuning of the drive. 

Axis Manager allows you to program the drive parameters specifically for the 

motor to which the LVD is connected, and for the particular operation that the 

drive will be performing in the machine. 

The following sections present a brief overview of the menus and elements in the 

interface. The functions are explained in greater depth where relevant elsewhere 

in this manual. 

4.2.2 Using Axis Manager 

From the Windows Start menu or the shortcut on your desktop, activate Axis 

Manager. 
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Figure ‎4-1. Axis Manager Software Interface    

The Axis Manager window has four function areas: 

Toolbar  Contains menus and quick access buttons. 

Sidebar  Contains a navigation menu for the System tree and Drive 

nodes.  

Main Screen Displays various interactive screens for viewing, setting and 

testing parameters and drive configurations. 

Status Bar Displays messages and warnings. (Refer to the chapter 

Troubleshooting.) 

4.2.3 Toolbar 

The toolbar provides quick access to the most commonly used functions in Axis 

Manager. 

< |  > Backward/Forward. Return to previously opened screens. 

Offline| Online Disconnects communication between the drive and the 

computer. Useful when the serial port is required for 

another application, such as Vulcan.  

Serial | CANopen A dropdown list. Selects the protocol to be used for 

communication with the drive. 

Enable | Disable A toggle button. Changes the Enabled/Disabled state of 

the drive. 

Recorder Opens the Recording application. (See Section ‎4.6.11.)  

Watch Opens the Watch dialog box. Allows you to monitor a set 

of parameters at a selectable sample rate. 

Save to EEPROM Writes the parameters to the drive’s non-volatile memory 

(EEPROM). 
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Add Drive  Opens a dialog box and prompts for the settings to 

establish the connection between a drive and Axis 

Manager. 

Remove Drive Deletes the connection between the drive and Axis 

Manager. Removes the drive node from the System tree. 

Emergency Stop When pressed, disables all the drives that are connected 

to Axis Manager. 

 

4.2.4 Sidebar  

The sidebar on the left side of the screen contains a navigational menu that 

allows you to select the System and Drives you want to work with. 

 

Figure ‎4-2. System Tree and Drive Node/s   

The system tree (root) has one or more nodes. Each node is a single drive in 

the system. Each node is represented by a specific user-defined name that is 

assigned during the configuration. Each node has a specific drive address. 

In the example shown in Figure ‎4-2, the system is called Drives, and the drive 

is named LVD. 

Note: The system name is predefined and cannot be modified. The drive name 

is user-defined. 

4.2.5 Menus 

File 

The File menu provides options for saving and loading files that contain the 

configuration data for drives and systems.  

 A drive is a single drive with a specific drive address; it is one node on the 

system tree. 

It is recommended to save individual drive configurations so that the 

settings and parameters can be reused, for example, to add a drive to the 

same system, or to create another system with the same drive. 
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The *.drive file is for use in Axis Manager only. In addition to the drive 

parameters, the file contains the settings defined when establishing the 
connection between Axis Manager and the drive (refer to Section ‎4.3.1): 

 Drive address 

 EDS file location (if using CANopen) 

 Motor name (if selected from the Motors database) 

 A system is a configuration of multiple drives; it is the root of the tree. 

When you conFigure multiple drives, saving the system saves the settings 

and parameters of all the drives contained in the system. 

The *.system file is for use in Axis Manager only. 

Open Loads the *.drive or *.system configuration file from 

the host computer. 

Save Saves/Saves As the *.drive or *.system configuration 

file to the host computer. 

Close System Closes the currently loaded system configuration. 

Recent Systems Displays a list of recently opened systems. 

Exit Closes Axis Manager. 

 

For more options and information regarding parameter and configuration files, 

refer to Section ‎4.5.2 

View 

The View menu provides an option to refresh the screen. You can also use F5 

for this purpose. 

Tools 

The Tools menu provides access to the same functions that are on the Axis 

Manager toolbar, described in Section ‎4.2.3. 

It also has an Options item, which opens a dialog box for selecting 

communication settings.  

Help 

The Help menu allows you to view the current version and build of Axis 

Manager. 

4.2.6 Status Bar 

The status bar at the bottom of the computer screen displays the status of the 

drive. 

A constant notification indicates whether the drive is enabled or disabled. 

Warning messages are highlighted in yellow and may flash. Warnings are 

displayed when you attempt to assign an invalid value to a parameter. While a 

warning is in effect, the drive remains in its current enabled/disabled state. 

Fault messages are highlighted in red and may flash. Faults occur when settings 

or conditions may cause improper operation of the drive/motor and/or 

equipment damage. When a fault occurs, the drive becomes disabled. 
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For more information about status messages, and how to resolve faults, refer to 

the chapter Troubleshooting. 

4.3 Connecting to a Drive 

4.3.1 Defining the Connection 

1. From the Axis Manager toolbar, select the type of communication protocol to 

be used for communication between the drive and the host computer: 

 Serial (RS-232) 

 CANopen 

2. From the Axis Manager toolbar, select Tools > Options to define and verify  

the settings for serial or CAN communication.  

The Options dialog box opens. 

  

 Figure ‎4-3. Options Dialog Box 

The Options dialog box allows you to define the communication properties of 

the system. 

3. Define and/or verify the following settings: 

 For Serial communications, set the COM port and the baud (data 

transfer) rate. 

 The COM port is the COM port of the host computer to which the 

serial cable is connected.  

 The baud rate for the LVD is fixed at 115200 bps. 

 For CANopen communications, select the CAN interface device that is 

being used. Currently only one device is defined.  

At present, Axis Manager can communicate only with the Peak Systems 

PCAN-USB dongle. For more information on this product, go to the Peak 

Systems website. 

In future software versions, additional devices will be supported, and 

will be available for selection in the list of CAN Devices. 

4. From the toolbar, select Add Drive. 

The Add Drive dialog box opens. 

http://www.peak-system.com/Product-Details.49+M578cbdb898b.0.html?&L=1&tx_commerce_pi1%5bcatUid%5d=6&tx_commerce_pi1%5bshowUid%5d=16
http://www.peak-system.com/Product-Details.49+M578cbdb898b.0.html?&L=1&tx_commerce_pi1%5bcatUid%5d=6&tx_commerce_pi1%5bshowUid%5d=16
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 Figure ‎4-4. Add Drive Dialog Box, Part One  

5. Enter the required information in the dialog box: 

Drive Name Drive #1 is the default drive name. 

It is recommended that you provide a name for the 

drive that reflects the function it performs, such as Axis 

1 or Axis-X. 

Drive Address The drive address can be any value, from 1 to 127. 

The value you enter must match the drive address 

defined by the DIP switches (set during installation).  

Note: If you enter the wrong drive address (that is, the 

drive address does not match the DIP switch settings), 

the drive will be defined but considered disconnected. 

An error message (No online drives found) will be 

displayed when you attempt to make the connection. To 

remedy, select Remove Drive, and then repeat the 

steps to connect the drive using the correct drive 

address. 

EDS File This field is displayed only when CANopen 

communication is defined. 

Click the browse button to select and load the EDS file. 

The EDS (electronic data sheet) file can be downloaded 

from the LVD product page on the Servotronix website. 

 

6. Click Next. Another dialog box prompts you for a parameter file.  

   

 Figure ‎4-5. Add Drive Dialog Box, Part Two 

http://www.servotronix.com/LVD.html
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7. Select the source of the parameters to be loaded: 

Upload from 

online drive 

The drive is considered online after its connection to 

the host computer has been established.  

Select this option if you want to upload the parameters 

that are currently in use in the drive.  

Upon first use of the drive, factory-set parameters are 

loaded. Afterwards, the EEPROM contains the set of 
parameter values last saved. Refer to Section ‎4.5.2. 

Upload from 

PRM file 

Select this option if you have saved parameters on your 

PC from this or another drive, and want to load those 

parameters to this drive. Browse to the *.prm file and 
select it. Refer to Section ‎4.5.2. 

Note: The drive is shipped with factory defaults loaded. To reset the drive 

to its factory defaults, use the Load Factory Defaults option in the Drive 
Parameters screen. Refer to Section ‎4.5.2. 

8. Click Finish.  

The system displays a message indicating it is retrieving the parameters for 

the drive.  

The Drives screen opens.  

  

 Figure ‎4-6. Drives Screen – Defined Drives 

9. In the Defined Drives box, click on the name of one of the drives. (If you 

have connected to only one drive, the list will contain just one name.)  

The Drives screen indicates that the drive is now connected 

(communicating) with the host computer. The drive is now online. 

The options in the toolbar are now enabled. 

  

 Figure ‎4-7. Drives Screen – Drive Connected 
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If you entered the wrong drive address in Step 5, or if the communication 

parameters are incorrect, an error message is displayed when you attempt 

to make the connection. 

  

Click OK. The Drives screen indicates that the drive is defined but not 

connected. 

  

 Figure ‎4-8. Drives Screen – Drive Disconnected 

From the toolbar, select Remove Drive. 

10. Repeat Steps 5 through 9 using the correct drive address. 

11. Repeat Steps 5 through 9 for each drive that will be used in the application. 

4.3.2 Drive Status Screen 

 In the system tree, click on the drive name to expand the node, and select 

Status. 

The Drive Status screen is displayed. 
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 Figure ‎4-9. Drive Status Screen 

The Drive Status screen shows the current properties and status of the 

selected drive. It allows you to select the drive’s Operation Mode and 

PWM Frequency. All other fields are read-only.  

It also displays current and previous faults. If No Faults is displayed in the 

Current Faults field, you can proceed to configure the parameters for the 

drive. 

4.4 Enabling/Disabling a Drive 

Warning: The drive must be disabled while parameters are being set. 

The state of the drive is indicated in the following locations: 

 Toolbar  

 Status bar at bottom of window 

 Status field in the Drive Status screen 

 

To disable the drive, use either of the following: 

 The Disable button on the toolbar. 

 The Disable option in the Tools menu.   

Similarly, to enable the drive, use either of the following: 

 The Enable button on the toolbar. 

 The Enable option in the Tools menu.   
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4.5 Managing Drive Parameters 

4.5.1 Drive Parameters Screen 

 In the System tree, expand the Drive node, and select Parameters. 

The Drive Parameters screen is displayed. 

  

 Figure ‎4-10. Drive Parameters Screen 

The Drive Parameters screen allows you to view and modify the drive 

parameter values. 

Show by 

Groups 

When this option is selected, parameters are listed in 

groups according to function, such as velocity, current, 

and position. 

When not selected, parameters are listed 

alphabetically. 

Change the 

Value of a 

Parameter 

To change a parameter value, click on the row of the 

parameter you want to modify.  

A dialog box opens, showing the current value for the 

parameter, as shown in the example: 
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Note the displayed units, minimum values, and 

maximum values. Be sure the parameter value you set 

is within the allowed range. 

Note: If you attempt to set a value that exceeds the 

limits of either the minimum or maximum value, the 

parameter is not changed, and an error message  

displays “VALUE OUT OF BOUNDS”. 

 

For detailed descriptions of parameters, refer to the LVD VarCom Reference 

Manual. 

4.5.2 Loading and Saving Parameters 

The LVD drive has several types of memory for storing the drive’s parameters: 

 Flash: Non-volatile memory. It holds the drive’s default parameter values. 

(It also contains the drive’s firmware.)  

 RAM: Volatile memory. The drive’s working memory. Parameter values are 

maintained in RAM while you configure and test the drive and adjust 

parameters. If power to the drive is disconnected, any unsaved changes in 

the parameters will be lost. 

 EEPROM: Non-volatile memory, stores the parameters even when power is 

shut off. After you have tested and confirmed that the drive is performing as 

intended, save the parameters to the EEPROM. (You should also save them 

to a file as a backup.) 

During power up, the LVD loads parameter values from the EEPROM to the RAM, 

and a checksum of these parameter values is calculated. If the checksum is 

invalid, default parameter values (which are hard-coded in the drive’s firmware) 

are loaded into RAM and an EEPROM Checksum Fault is set. 

The Drive Parameters screen also includes options for loading and saving the 

drive’s parameters. 

Save to File Axis Manager saves parameters in a file named 

*.prm. This is a tab-delimited text file, which can be 

read using any text editor or spreadsheet application, 

and uploaded directly from a PC to the drive. 

Load from File Loads the parameters from *.prm file to RAM. 

Open Parameters in 

Excel 

Activates Excel and displays the parameters currently 

in RAM in an Excel worksheet. 
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Save to EEPROM Saves the parameters currently in RAM to the 

EEPROM. 

Load from EEPROM Loads into RAM the parameter values last saved in 

the EEPROM. Use this option to revert to the previous 

configuration. 

Load Factory 

Defaults 

Loads the factory-defined parameters from the 

drive’s Flash memory. 

 

The following diagram illustrates the relationships among the different types of 

memory. 

 

Figure ‎4-11. Drive Memory Architecture 

For more information on the commands for saving and loading parameters, refer 

to the LVD VarCom Reference Manual. 
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4.6 Configuring Parameters 

Warning: Disable the drive before manipulating Motor and Feedback 

parameters. 

Many parameters can be modified while the drive is enabled. Exercise caution, 

however, as motor behavior will change. 

If a parameter cannot be modified while the drive is enabled, Axis Manager will 

prompt you to disable the drive. 

While setting the parameters, pay close attention to any warning or error 

messages displayed by Axis Manager. 

4.6.1 Configuration Sequence 

It is recommended that you perform the drive configuration according to the 
sequence shown in Figure ‎4-12. 

 

Figure ‎4-12. Drive Parameter Configuration Sequence 
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4.6.2 Tuning and Testing 

Axis Manager provides several methods for modifying and testing parameters 

that you can use during the configuration process to optimize and evaluate the 

drive’s performance. 

 Tuning. Available in each of the Control Loop parameter screens. For more 
information, refer to Section  ‎4.6.9. 

 Motion Profile testing. Accessed from the navigation menu in the Sidebar. 

For more information, refer to Section ‎4.6.10. 

 Recorder. Accessed from the Toolbar. For more information, refer to 
Section ‎4.6.11. 

4.6.3 Safety Limit Parameters 

To ensure proper and safe operation of the drive, begin the drive configuration 

by setting the parameters that define the limits of velocity, current, position and 

acceleration/deceleration. 

Warning: Many parameters can be modified while the drive is enabled.  

Exercise caution, however, as motor behavior will change. 

While setting the parameters, pay close attention to any warning or error 

messages displayed by Axis Manager. 

It is easiest to use the Drive Parameters screen for viewing and modifying the 

values of the parameters. The various configuration screens also enable access 

to the relevant parameters. 

Current IMAX Gets/sets the maximum peak current for the 

drive. If motor current exceeds 1.2 of IMAX, 

the drive will issue a fault. 

 ISAT Gets/sets the current saturation value. 

If you attempt to use a higher value, the 

current command will not exceed the ISAT 

value and a fault will not be issued. 

 ICONT Gets/sets the value of maximum continuous 

current for the drive. 

 I2TLIM Gets/sets the I2T integrator limit value. If this 

value is exceeded, the drive will issue a fault. 

Setting I2TLIM to 0 disables this function. 

Note: The I2T integrator limits the energy 

delivered to the motor to the continuous 

current rating of the drive; it is calculated:  

I2T=    dtII cont

2
 

Velocity VOSPD Gets/sets the velocity value that triggers the 

over-speed protection fault. 

 VLIM Gets/sets the velocity limit value. 

The velocity command will not exceed the 

VLIM value. Values higher than VLIM will be 

ignored and a fault will not be issued.  
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Acceleration/ 

Deceleration 

ACC Gets/sets the acceleration rate in the velocity 

and position loops. 

 DEC Gets/sets the deceleration rate in the velocity 

and position loops. 

 ACCLIM Gets/sets the maximum acceleration/ 

deceleration value. 

If the drive detects acceleration or 

deceleration that is a higher than the ACCLIM 

value, it will issue a fault. Setting ACCLIM to 

0 disables this function. 

Position PLIMPOS Gets/sets the maximum position limit for 

motion. 

The drive will not accept MOVE commands 

beyond this position. Upon reaching this limit 

the drive will execute a STOP command. 

 PLIMNEG Gets/sets minimum position limit for motion. 

The drive will not accept MOVE commands 

beyond this position. Upon reaching this limit 

the drive will execute a STOP command 

 PSTOPMODE Configures the STOP functionality. Defines 

how the LVD reacts to the software position 

limits PLIMPOS and PLIMNEG. 

 PEMAX Gets/sets the position error value that 

triggers the position error fault. 

This parameter is used in Point to Point, 

Interpolated Position and Jog in Position 

operation modes. 
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4.6.4 Motor Parameters 

Warning: Disable the drive before modifying Motor parameters. 

1. In the System tree, expand the Drive node, and select Motor. 

  

 Figure ‎4-13. Motor Parameters Screen 

The Motor screen lets you define the properties of the motor that is 

connected to the drive, either by selecting a motor from a predefined list or 

by manually entering values. 

2. To load a predefined motor, use the following option: 

Select Motor 

attributes from 

List 

Press this button and select a motor from a list of 

known motors. Parameters for these motors will be 
loaded automatically. Refer to Figure ‎4-14. 

 

To manually enter motor attributes, use the Motor Details options: 

Motor Type Select either BLDC (brushless DC) or DC (brush DC) 

Number of 

Poles 

Enter the number of individual poles for the motor.  

Note: Not pairs of poles. 

Motor Phase Note: Motor phase can be defined after testing in 

Current Loop. 
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 Figure ‎4-14. List of Predefined Motors 

3. When finished setting the Motor parameters, continue to the Feedback 

parameters. 

4.6.5 Feedback Parameters 

Warning: Disable the drive before modifying Feedback parameters. 

1. In the System tree, expand the Drive node, and select Feedback. 

  

 Figure ‎4-15. Feedback Parameters Screen 

The Feedback Parameters screen contains the following elements: 

Position Feedback 

(counts) 

This field shows the motor position in encoder 

counts. 

Displays the motor position, in encoder counts, 

relative to its initial position when the drive was 

turned on. 
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Feedback Type Select the device to be used for feedback: AB, 

Halls or Index. 

Feedback Direction Select either clockwise or counterclockwise for 

the positive direction of feedback. 

Encoder Resolution 

(# of lines) 

Enter the encoder resolution. 

Note: Enter the number of lines per revolution 

(not counts per revolution). 

Halls This section of the screen displays an animation 

representing the status of the Hall sensors, the 

motor shaft angle, and the electrical angle.  

Config Calculates and sets the drive’s unit scaling 

according to the feedback parameters. 

 

2. To configure the feedback parameters, do the following: 

 Select the type of feedback. 

 Set the direction of the encoder. 

 Set the encoder resolution. 

3. Click Config. 

4. If possible, manually turn the motor shaft one rotation in the positive 

direction. Look at the Position Feedback field, and confirm that the 

number of counts is as expected.  

5. If possible, repeat Step 4, turning the shaft in the negative direction. 

6. If you are satisfied with the behavior, continue to the Current Loop 

parameters. 
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4.6.6 Current Loop Parameters 

Warning: Many parameters can be modified while the drive is enabled.  

Exercise caution, however, as motor behavior will change. 

1. From the Drive node select Current Loop. 

  

 Figure ‎4-16. Current Loop Parameters Screen 

The current loop is implemented by a proportional-integral-derivative (PID) 

control algorithm. 

2. User-configurable parameters are displayed in blue boxes in the Current 

Loop diagram. You can click on a parameter box to modify its settings.  

Alternately, click Tune, and use the Tuning utility to set and test the current 
loop parameters. Refer to Section ‎4.6.9. 

The following parameters are user-configurable in the Current Loop: 

IGZ Gets/sets the separation term for gain paths of the current PID 

loop. 

IGP Gets/sets the proportional gain for the current PID loop. 

IGI Gets/sets the integral gain for the current PID loop. 

IGD Gets/sets the derivative gain for the current PID loop. 

ISAT Gets/sets the current saturation value. Refer to the safety limit 

parameters in Section ‎4.6.3. 

 

The Current Loop screen also includes a table of Additional Parameters, which 

are relevant to current but not to control. You can modify these parameters in 

the same way you work with parameters in the Drive Parameters screen. Refer 
to Section ‎4.5.1 and to the LVD VarCom Reference Manual. 

To verify the behavior of the current control loop, go to the Motion screen, and 

use the Torque Profile tab to test the current loop step response. Refer to 
Section ‎4.6.10. 
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4.6.7 Velocity Loop Parameters 

Warning: Many parameters can be modified while the drive is enabled.  

Exercise caution, however, as motor behavior will change. 

1. From the Drive node select Velocity Loop. 

  

  Figure ‎4-17. Velocity Loop Parameters Screen 

The velocity loop is implemented by a pseudo-derivative feed forward 

(PDFF) control algorithm. 

2. User-configurable parameters are displayed in blue boxes in the Velocity 

Loop diagram. You can click on a parameter box to modify its settings.  

Alternately, click Tune, and use the Tuning utility to set and test the current 
loop parameters. Refer to Section ‎4.6.9. 

The following parameters are user-configurable in the Velocity Loop: 

VGI Gets/sets the integral gain for the velocity loop. 

VGPR Gets/sets the proportional gain for the velocity loop. 

VGPF Gets/sets the feedback proportional gain of the velocity loop. 

VGDR Gets/sets the derivative gain for the velocity loop. 

VGDF Gets/sets the feedback derivative gain for the velocity loop. 

VLPF Gets/sets the low pass filter cutoff frequency for the velocity 

loop. 

VLIM Gets/sets the velocity limit value. Refer to the safety limit 

parameters in Section ‎4.6.3. 

 

The Velocity Loop screen also includes a table of Additional Parameters, which 

are relevant to velocity but not to control. You can modify these parameters in 

the same way you work with parameters in the Drive Parameters screen. Refer 
to Section ‎4.5.1 and to the LVD VarCom Reference Manual. 
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To verify the behavior of the velocity control loop, go to the Motion screen, and 

use the Velocity Profile tab to test the current loop step response. Refer to 
Section ‎4.6.10. 

4.6.8 Position Loop Parameters 

Warning: Many parameters can be modified while the drive is enabled.  

Exercise caution, however, as motor behavior will change. 

1. From the Drive node select Position Loop. 

  

 Figure ‎4-18. Position Loop Parameters Screen 

The position loop is implemented by a proportional-integral-derivative (PID) 

control algorithm with velocity and acceleration feed forward options. 

2. User-configurable parameters are displayed in blue boxes in the Position 

Loop diagram. You can click on a parameter box to modify its settings.  

Alternately, click Tune, and use the Tuning utility to set and test the current 

loop parameters. Refer to Section ‎4.6.9. 

The following parameters are user-configurable in the Position Loop: 

PGP Gets/sets the proportional gain for the position PID loop. 

PGI Gets/sets the integral gain for the position PID loop. 

PGD Gets/sets the derivative gain for the position PID loop. 

PGFFV Gets/sets the feed forward velocity term gain for the position 

PID loop. 

PGFFA Gets/sets the feed forward acceleration term gain for the 

Position PID loop. 

PGISATIN Gets/sets the input saturation level for the position loop 

integrator.  

VLIM Gets/sets the velocity limit value. Refer to the safety limit 
parameters in Section ‎4.6.3. 
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The Position Loop screen also includes a table of Additional Parameters, which 

are relevant to current but not to control. You can modify these parameters in 

the same way you work with parameters in the Drive Parameters screen. Refer 
to Section ‎4.5.1 and to the LVD VarCom Reference Manual. 

To verify the behavior of the position control loop, go to the Motion screen, and 

use the Position Profile tab to test the current loop step response. Refer to 
Section ‎4.6.10. 

4.6.9 Control Loop Tuning 

Each control loop screen has a Tune button that activates a dedicated Tuning 

utility. Each Tuning screen enables you to adjust the relevant control loop gains 

and parameters in order to achieve the desired performance. 

Figure ‎4-19 shows, for example, the Tuning screen for the Current control loop. 

 

Figure ‎4-19. Tuning Screen for Current Loop 

Clicking the Test button initiates a step command. The tuning screen displays 

the response to the command with the gains currently configured. 

Warning: Use with caution. As soon as the Test button is pressed, Axis Manager 

activates the selected control loop and enables the drive, and the motor will 

begin to move. 

The tuning screen also displays information such as rise time and overshoot for 

the step response. 
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4.6.10 Motion Profile Testing 

Axis Manager includes a motion profile testing utility.  

The Motion screen has tabs for the three basic types of operation: Torque 

(current), Velocity (jog) and Position.  

When activated, the Motion screen opens to the profile tab that corresponds to 
the operation mode currently defined in the Status screen. (See Section ‎4.3.2.) 

 CURRENT operation mode: Torque Profile tab. 

 JOG operation mode: Velocity Profile tab. 

 POSITION operation mode: Position Profile tab. 

Each tab allows you to modify parameters, issue commands, and monitor 

feedback for the selected profile. 

Figure ‎4-20 shows, for example, the Velocity Profile tab in the Motion screen. 

 

Figure ‎4-20. Motion Screen – Velocity Profile Tab 

Each tab has three sections:  

Move Varies in each tab: 

 Torque tab: Apply Torque (current) 

 Velocity tab: Jog 

 Position tab: Move (in encoder counts) 

GO initiates the command. 

Stop decelerates the drive to a halt using the DEC value. 
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Profile Varies in each tab: 

 Torque tab: Current Feedback 

 Velocity tab: Velocity Feedback acceleration/ 

deceleration 

 Position tab: Cruise Velocity acceleration/ deceleration 

Position Same in all three tabs. 

Displays information about the position limits and position 

feedback. 

Allows you to select the type of position limits: 

 Pos: 2147483647, Neg: -2147483647 

 Pos: Positive position limit, Neg: Negative position 

limit 

 Pos: Positive position limit, Neg: Negative position 

limit and stop on PSTOP. 

 

The Motion screen also includes a table of Additional Parameters, which are 

relevant to motion. The parameters are the same in each tab. You can modify 

these parameters in the same way you work with parameters in the Drive 

Parameters screen. Refer to Section  ‎4.5.1 and to the LVD VarCom Reference 

Manual. 

4.6.11 Data Recording 

Axis Manager has a data Recorder application for testing the drive’s 

performance. 

To activate the Recorder screen, use either of the following: 

 The Recorder button on the toolbar. 

 The Recorder option in the Tools menu.   

 

Figure ‎4-21. Recorder Screen 
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The Recorder allows recording of up to four different parameters.  

The field below the plot area displays a textual summary of the currently defined 

settings for recording. 

Grid When enabled, gridlines are displayed in the plot 

background.  

Zoom When enabled, allows you to select and enlarge a section 

of the plot. 

Pan When enabled, allows you to use the mouse to drag the 

plot. 

Default Scaling Resets the plot to its default size. 

Data Displays the data in textual format rather than as graph. 

Persist Adds newly recorded data on top of the existing plot rather 

than clearing data and starting a new plot. 

Legend When enabled, a legend for the plotted parameters is 

displayed above the plot. 

Channels Allow you to select up to four parameters for recording. 

Sample Rate Allows you to set the time interval between two 

consecutive samples. Defined in microseconds. 

The LVD sampling rate is 62.5 μs.   

# Points per 

Channel 

Allows you to select the number of data points to record. A 

maximum of 8184 points can be recorded for all channels 

combined. 

The green bar below this field indicates the current usage 

of the recording buffer. 

Start Condition  On Start Recording button click: Recording will 

begin when the Start Recording button is pressed. 

 On Start Recording button click AND [options]: 

Recording will begin when defined conditions exist after 

the Start Recording button has been pressed. This is 

the trigger point. 

Trigger Point: Sets the number of points to be 

recorded prior to the trigger point. [AXY] 

Show Marks the trigger point with a vertical line on the plot. 

Start Recording Begins the recording. 
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4.7 Digital Inputs and Outputs 

The Digital IO screen displays the status of the IOs, and allows you to set the 

functionality of up to four digital inputs and two digital outputs. 

 

Figure ‎4-22. Digital Inputs/Outputs Screen 

State Displays the status of the inputs and outputs:  

 1: On (green) 

 0: Off (red) 

Function  Digital Inputs: Allows you to select the input 

functionality, or to define the input as Disabled. 

 Digital Outputs: Allows you to select the event or 

condition that triggers an output signal, or to define 

the output as Disabled. 

Polarity Allows you to select whether or not to the logic of the 

output is inverted. 

 Rising Edge  

 Falling Edge 

 Window High: High limit of the function window 

 Window Low:  Low limit of the function window 
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4.8 Analog Inputs 

The Analog IO screen displays the analog input voltage level, and allows you to 

set the analog input offset value. 

 

Figure ‎4-23. Analog Inputs/Outputs Screen 

Value Displays the value of the analog input, in millivolts. In 

addition, the graphic display indicates the current value of 

the input within the measurable range. 

Zero Offset Sets the current value of the analog input to 0, making it 

the reference level for the input signal. 

4.9 Homing 

The Homing screen allows you to select the methods and parameters to be used 

for homing the motor, and to initiate and monitor the homing process. 

 

Figure ‎4-24. Homing Screen 

Find Home Initiates the homing process. 

Stop Stops the homing process. 

Status Displays the current state of the system: Homed or Not 

Homed  
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Offset Sets an offset, in counts, for the Home position. 

Fast Velocity The velocity used during search for the home switch. 

Slow Velocity The velocity used during search for the index signal. 

Acceleration The value of acceleration and deceleration during the 

homing process. 

Show All 

Methods 

When selected, displays the complete list of 35 homing 

methods, per CANopen standard. 

For more information about homing methods, refer to 

the document “CANopen Device Profile Drives and 

Motion Control” (CiA Draft Standard Proposal 402). 

Only Shows 

Methods Which 

Include: 

When selected, allows you to choose one or more 

options for the home search: 

 Position (CW) Limit Switch 

 Negative (CCW) Limit Switch 

 Home Switch has two options: level trigger or edge 

trigger  

 Encoder Index 

Method # Lists either all methods, or just the homing methods 

that match the option/s selected. 

[graphic] A graphic display representing the method selected for 

the homing process. 
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5 Firmware Upgrade 

Note: Upgrading the drive is a sensitive operation. Pay close attention when 

performing this task.   

The Vulcan application is used for upgrading the LVD firmware. Vulcan burns 

firmware onto the drive’s flash memory via a serial connection. 

Vulcan is available for download from the Servotronix website. 

5.1 Preparation 

1. Important: Before upgrading the firmware, backup the drive parameters 

since parameter settings may be lost during the upgrade. After the upgrade 

is completed, the parameters can be reloaded/restored. 

2. On the Servotronix website, go to the LVD product page.  

3. Download and save the VulcanSetup.ZIP file to the host computer. 

4. Run VulcanSetup.exe and follow the on-screen prompts to install the 

software. 

5. By default, the software is installed under Windows Program Files in the 

folder \Servotronix\Vulcan. 

5.2 Using Vulcan 

1. From the Windows Start menu, go to [All] Programs > Servotronix > 

Drive Tools > Vulcan. 

2. Typically, you will use the Software (Boot Type) upgrade method, according 
to the instructions in Section ‎5.3. 

If using the Hardware (Boot Type) method, follow the instructions in 
Section ‎5.4. 

  

 Figure ‎5-1. Vulcan Application for Firmware Upgrade 

http://www.servotronix.com/LVD.html
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Port Name The COM port of the host computer to which the LVD is 

connected by means of a serial cable. 

Make sure this COM port is not used by any other 

application. 

If the port name is not included in the list, use the 

blank field to type in the name of the port you want to 

use.   

Baud Rate For the Software (Boot Type) upgrade method, the rate 

is 115200. 

For the Hardware (Boot Type) upgrade method, the 

rate is 19200. 

Vulcan automatically sets the correct baud rate when 

the Boot Type is changed. 

Boot Type The method used for burning the new firmware on the 

drive’s flash memory, either Software or Hardware, as 

explained below. 

Processor Displays the Type and Revision of the processor used in 

the LVD.  Read-only field.  

New Version 

File 

The path and name of the file containing the firmware 

upgrade. 

Burn Starts the burning operation. 

5.3 Software Boot Upgrade 

The software boot method is used for upgrading a drive that is operational and 

able to communicate with the PC via a serial connection. 

Note: Parameter settings are not erased during the software boot upgrade. 

However, the ECHO parameter is set to 0 (inactive) during the upgrade, and will 

need to be reset after the procedure is completed. 

1. Turn the drive power off, then turn it on. 

2. Complete the selections and information required in the Vulcan screen: 

 Port name 

 Make sure Boot Type is Software 

 Make sure Baud Rate is 115200. 

3. Browse to and select the firmware upgrade file (*.i00). 

4. Press Burn to start the upgrade. 

A progress bar and messages are displayed on the screen during the 

upgrade operation. 

When performing a software boot upgrade, parameters are automatically 

backed up and restored. 

Warning: During the burning operation, do not close the application, do not 

disconnect the serial cable, and do not turn off the drive. Any of the actions 

may cause the drive to stop responding. 
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If the upgrade operation is successful, a message is displayed on screen, 

and you can continue to Step 5. 

If the upgrade operation is unsuccessful, a red fault message flashes, and 

you are prompted to view the operation log file. 

5. Turn off the drive power, then turn it on. 

If the drive does not respond after cycling power, repeat the upgrade using 
the hardware boot method, as described below in Section ‎5.4.  

5.4 Hardware Boot Upgrade 

The hardware boot method is used for upgrading a drive when the software boot 

method fails, or when the drive does not respond when power is switched on.  

Note: Parameter settings are erased during the hardware boot upgrade and 

must be restored after the upgrade is completed. 

These instructions assume that the hardware is functional. 

1. Make sure the drive power switch is off. 

2. Complete the selections and information required in the Vulcan screen: 

 Port Name 

 Make sure Boot Type is Hardware 

 Make sure Baud Rate is 19200 

3. Browse to and select the firmware upgrade file (*.i00). 

4. Using a non-metallic instrument, press and hold the boot switch on the 
side of the LVD (see Figure ‎3-6) and simultaneously turn on the drive. 

5. Press Burn to start the upgrade. 

A progress bar and messages are displayed on the screen during the 

upgrade operation. 

6. If the upgrade operation is successful, a message is displayed on screen, 

and you can continue to Step 7. 

7. Turn the drive power off, then turn it on. 

8. Restore the drive parameters. 

If the upgrade operation is unsuccessful, a red fault message flashes, and you 

are prompted to view the operation log file. 

If the error persists, send a copy of the operation log file to Servotronix 

Technical Support at tech.support@servotronix.com 

 

 

mailto:tech.support@servotronix.com
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6 Troubleshooting 

6.1 Built-in Protection 

When a drive fault occurs, the fault is automatically latched and the drive is 

disabled. Faults must be explicitly cleared before the drive can be reenabled. 

Drive faults are described in Section ‎6.3. 

6.2 Diagnostic Tools  

6.2.1 LEDs 

The LVD has 2 LED indicators. Refer to Section ‎3.6  

Table ‎6-1. LED Indicators 

Name Color Function 

Bus Yellow  ON – Bus power is connected and powered to at least 

5 VDC. 

Status Green Blinking – The drive is operational and ready to be 

enabled. No faults. 

ON – The drive is enabled. No faults. 

 Red ON – A fault has been detected and needs attention. 

The LED remains ON until the error is resolved by user 

or the system itself. 

Blinking – A fault that was detected no longer exists, 

but has not yet been cleared. (Use the CLRFLT 

command or the Drive Status screen to clear the fault). 

 

6.2.2 Axis Manager Status Messages 

The Axis Manager interface displays the status of the drive in the status bar, at 

the bottom left of the screen. 

Warning:  

Flashing yellow 

 

Indicates that the parameter values you have entered 

are out of range and cannot be used. See Figure ‎6-1. 

Clicking the Warning message opens a dialog box that 

displays information and allows you to correct the 

error.  

Fault:  

Flashing red 

 

Indicates that a drive fault has occurred and drive has 
been disabled. See Figure ‎6-2. 

Clicking the Fault message opens the Drive Status 

screen, which displays faults and allows you to clear 
them. See Figure ‎6-3 and Section ‎6.3. 
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Communication 

Error: 

Steady red 

 

The far left of the status bar is reserved for indicating 

communication errors. This segment of the status bar is 

lit when Axis Manager is unable to communicate with a 
drive. See Figure ‎6-4. 

 

Figure ‎6-1. Warning Message in Status Bar 

 

Figure ‎6-2. Fault Message in Status Bar 

Figure ‎6-3. Faults Displayed in Drive Status Screen 

 

Figure ‎6-4. Communication Error Message in Status Bar 
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6.3 Faults 

Following are the fault notifications that the LVD recognizes. 

To troubleshoot the problem, perform the suggested solutions. 

For detailed explanation of the commands and parameters, refer to the LVD 

VarCom Reference Manual. 

Acceleration/Deceleration Violation  

Description  The motor acceleration or deceleration is greater than 

ACCLIM. 

Solution 1. Check the values of control loop parameters. 

2. Check the demanded velocity, acceleration and 

deceleration. 

3. Increase ACCLIM if needed, or set it to 0 to disable this 

functionality. 

Commutation Fault  

Description  A mismatch between the position of the Hall sensors and the 

encoder. 

Solution 1. Check MENCRES, MENCDIR and the Halls cable.  

2. Use CONFIG to reset the Halls commutation angle. 

EEPROM Checksum Fault  

Description  Checksum error while loading parameters. 

Solution 1. Use the LOAD command to reload the parameters from 

the EEPROM. 

2. Load the configuration file from the PC to the drive, save 

the configuration, and reset the drive. 

3. The EEPROM might be damaged. The drive requires 

service. 

EEPROM Reading Fault / EEPROM Writing Fault  

Description  The drive’s firmware could not access the EEPROM, during 

one of the following: SAVE, LOAD, CLRHST, TIMEON or 

TIMEEN 

Solution 1. Reset the drive, and try again. 

2. The EEPROM might be damaged. The drive requires 

service. 

Encoder Line Break  

Description  A disconnection of one of the encoder inputs was detected. 

Solution 1. Check the encoder cable wiring.  

2. If single ended encoder is used, set DIFFENC to 0 to 

configure the drive correctly. 
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General Error  

Description  Undefined error occurred. 

Solution Contact Technical Support for assistance. 

Halls/Address Read Failed  

Description  The drive’s firmware could not access the parallel to serial 

converter. 

Solution 1. Reset the drive, and try again. 

2. The parallel to serial converter might be damaged. The 

drive requires service. 

I2T Limit  

Description  Energy usage is higher than I2TLIM 

Solution 1. Check the parameter values in the control loops.  

2. Check the demanded velocity, acceleration and 

deceleration and motor load. 

3. Increase I2TLIM if needed, or set it to 0 to disable this 

functionality. 

Illegal Halls  

Description  Illegal state for the HALLS sensors reading. 

Solution 1. Check Halls cable wiring.  

2. Check that the Halls sensor is functioning. 

Over Current  

Description  Hardware or software over current was detected.  

Solution 1. Check the Current-Loop parameters (IGP, IGI).  

2. Increase IMAX or reduce ISAT 

Over Speed  

Description  Actual speed exceeds VOSPD value. 

Solution 1. Check the Velocity-Loop parameters (VGI, VGPR, VGPF).  

2. Increase VOSPD or reduce VLIM. 

Over Temperature  

Description  The temperature of the drive is higher than 90°C (194°F) or 

lower than -30°C (-22°F), or the temperature sensor has a 

malfunction. 

Solution 1. Check the drive operation conditions, using DRIVETEMP to 

read the measured temperature.  

2. Reduce the load on the drive. 
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Over Voltage  

Description  Bus voltage exceeds VBUSOV value. 

Solution 1. Check the bus power voltage.  

2. Increase the value of VBUSOV 

Position Command Error  

Description  The difference between two sequential position commands is 

greater than PDMAX. 

Note: Interpolated mode only. 

Solution 1. Check the motion controller configuration.  

2. Check the demanded velocity, acceleration and 

deceleration. 

3. Increase PDMAX if needed, or set it to zero in order to 

disable this functionality. 

Position Error  

Description  The difference between the position command and the actual 

position is greater than PEMAX. 

Solution 1. Check control loops parameters.  

2. Check the demanded velocity, acceleration and 

deceleration. 

3. Increase PEMAX. 

Under Voltage  

Description  Bus voltage is lower than VBUSUV value. 

Solution 1. Verify bus power connection  

2. Reduce the value of VBUSUV 

Velocity Error Fault  

Description  The difference between the velocity command and the actual 

velocity is greater than VEMAX. 

Solution 1. Check the parameter values in the control loops.  

2. Check the demanded velocity, acceleration and 

deceleration. 

3. Increase VEMAX if needed, or set it to 0 to disable this 

functionality. 

 

 


